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Resumen 

En el ámbito de las Ciencias, el inglés es la lengua dominante en la investigación, imprescindible 
en la formación del estudiante universitario, para garantizar una formación autónoma y continua. 
El objetivo de este trabajo es crear un diccionario de términos técnicos en inglés del ámbito de la 
Medicina y de la Ingeniería, que presentan plurales irregulares en la morfología inglesa ya que 
siguen las reglas de declinación griega y latina. Se creó una lista de términos provenientes del 
griego y el latín extraídos de manuales de ESP y de diccionarios técnicos. También se clasificaron 
los términos recopilados de acuerdo con su origen y la declinación que presentan. El primer paso 
fue crear una gramática flexiva en NooJ con reglas para cada uno de los grupos de sustantivos. 
Luego, se creó un diccionario que se vinculó con la gramática obteniendo 776 entradas. Se 
procedió a compilar el diccionario con todas las formas flexionadas generando un total de 1554 
entradas con todas las formas posibles que se definieron en la gramática flexiva. La creación de 
un diccionario de términos médicos e ingenieriles con NooJ ha demostrado ser una herramienta 
extremadamente valiosa ya que la gestión de la terminología es fundamental para garantizar la 
precisión y la claridad de la comunicación técnica y científica.  

Palabras clave: Plurales provenientes del latín/griego, Términos técnicos de medicina e ingeniería , 
Educación, Inflexiones 

 

CREATION OF A DICTIONARY OF ENGLISH NOUNS WITH IRREGULAR 

PLURALS IN THE FIELDS OF MEDICINE AND ENGINEERING 

Abstract 

English has become the dominant language of research in the field of science, essential in the 
training of university students to guarantee independent and continuous education. The aim of 
this work was to create a dictionary of technical terms of Greek and Latin origin in the field of 
Medicine and Engineering focusing on irregular plurals in the English morphology as they follow 
the rules of Greek and Latin declension. A list of Greek and Latin terms from ESP manuals and 
technical dictionaries was created. The collected terms were classified according to their origin 
and declension. The first step was to create an inflectional grammar in NooJ with rules for each 
of the noun groups. Respecting the order of these groups, a dictionary was created and linked to 
the grammar, obtaining 776 entries. It was then compiled with all the inflected forms generating 
a total of 1554 entries with all the possible forms that were defined in the inflectional grammar. 
The creation of a dictionary of medical and engineering terms with NooJ has proved to be an 
extremely valuable tool as terminology management is essential to ensure accuracy and clarity in 
technical and scientific communication.  
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1.  Introducción 

La lingüística computacional es un campo altamente interdisciplinar que se ocupa del 
procesamiento de las lenguas, en todos sus aspectos posibles, por medio de computadoras. Desde 
su creación a finales de los años 50 y de su configuración como disciplina autónoma, ha 
experimentado un crecimiento exponencial en distintas direcciones, recibiendo aportes de campos 
como la lingüística, que produce los modelos teóricos del lenguaje; la psicología, que proporciona 
un análisis de los procesos cognitivos; la teoría de la información, que analiza las modalidades 
comunicativas; las matemáticas y la estadística, que proporcionan las herramientas para expresar 
estos modelos de forma computacionalmente manejable; y, por supuesto, la informática en lo que 
se refiere al desarrollo de algoritmos para implementar los modelos teóricos de los fenómenos 
lingüísticos. De esta manera, NooJ se presenta como un software de desarrollo lingüístico, así 
como también un procesador de corpus que permite trabajar con las cuatro clases jerarquías de la 
gramática generativa de Chomsky. Su aplicación en el procesamiento de lenguaje natural se 
extiende desde la minería y la extracción de textos hasta la traducción automática y la generación 
de paráfrasis.  

El lenguaje es la base sobre la que construimos el sentido compartido de humanidad. 
Comunicamos hechos, así como también emociones; a través del lenguaje, adquirimos 
conocimiento por fuera de nuestro mundo de experiencias, y construimos nuestro entendimiento 
mediante el acto de compartir esas experiencias. La lingüística computacional nos brinda la 
oportunidad de desarrollar un entendimiento sólido, no solo de los mecanismos del procesamiento 
del lenguaje natural, sino también de las oportunidades de generar sistemas que generan un 
impacto y que tal vez algún día entienda a la humanidad a través del lenguaje. 

Resulta incuestionable la relevancia del idioma inglés en el ámbito académico en la actualidad, al 
extremo de volverse imprescindible en la formación del estudiante universitario, especialmente si 
se apunta al objetivo de garantizar una formación autónoma y continua. 

El vertiginoso avance del conocimiento y la inmediatez de las formas de comunicación e 
información en general, y dentro del ámbito académico en particular, han generado nuevas 
condiciones en la producción y transmisión de saberes.  

Por distintas condiciones y factores, el inglés se ha constituido en la lingua franca de lo que se ha 
dado en llamar la nueva sociedad informacional. Es por ello que el estudiante universitario 
necesita contar con herramientas que le permitan no sólo realizar una decodificación lingüística 
en este idioma sino, además, una lectura comprensiva, crítica y valorativa de los contenidos que 
circulan por esta comunidad global. 

En el ámbito de las Ciencias, el inglés es la lengua dominante en la investigación, 
independientemente del país de origen de los investigadores o de los estudios realizados. El 
enfoque que se aplican en la práctica docente en las facultades de Medicina e Ingeniería se inscribe 
en el de inglés con fines específicos y académicos, y apunta a la lectura comprensiva de textos 
relacionados con el área de pertenencia. El inglés con fines específicos (ESP, por sus siglas en 
inglés) es un tipo de enseñanza de la lengua inglesa que se centra en el desarrollo de la 
competencia lingüística en un ámbito o contexto específico que se adapta a las necesidades y 
objetivos específicos de los alumnos. 

Los cursos de ESP suelen dirigirse a alumnos que necesitan el inglés para fines profesionales o 
académicos, como la ingeniería, la medicina o el derecho. El contenido y las destrezas lingüísticas 
que se enseñan en estos cursos están directamente relacionados con los campos de estudio o 



 

APRENDO CON NOOJ. Vol. 3. Año 2023. ISSN:  2718- 8574 (En línea) 

trabajo específicos de los alumnos, lo que les permite comunicarse eficazmente en sus contextos 
profesionales, ya que les resulta relevante, significativo y aplicable a sus necesidades y objetivos.  

De manera similar, el inglés con fines académicos se centra en el desarrollo de las destrezas y los 
conocimientos lingüísticos necesarios para el estudio académico, y los cursos suelen estar 
dirigidos a futuros profesionales que se preparan para estudiar en un contexto académico 
angloparlante, como universidades, institutos o centros de investigación. Estos cursos pueden 
centrarse en el desarrollo de las destrezas académicas de lectura, escritura, comprensión y 
expresión orales, así como en el vocabulario académico y la gramática. 

El vocabulario médico y el vocabulario de ingeniería comparten algunas características comunes: 

 Términos técnicos específicos de sus respectivos campos que no se utilizan habitualmente 
en el lenguaje cotidiano. Por ejemplo, términos médicos como diagnóstico, pronóstico y 
síntoma son específicos del campo de la medicina, mientras que términos de ingeniería 
como fórmula, radio y fenómeno son específicos del campo de la ingeniería. 

 Raíces latinas y griegas: Los términos médicos y de ingeniería suelen tener raíces latinas 
y griegas. Términos médicos como cardio- (corazón) y neuro- (nervio) proceden del 
griego, mientras que términos de ingeniería como termo- (calor) y aero- (aire) proceden 
del griego y el latín. 

 Precisión y exactitud en el uso del lenguaje. La terminología médica debe ser precisa y 
exacta para garantizar que los diagnósticos y tratamientos sean eficaces, mientras que la 
terminología de la ingeniería debe ser precisa y exacta para garantizar que las estructuras, 
sistemas y máquinas funcionen correctamente. 

 Especialización: Ambos campos requieren especialización y un profundo conocimiento 
de terminología y conceptos específicos. 

Este trabajo se centrará en los sustantivos en inglés que se originaron en el latín o el griego y que 
son de uso habitual en Medicina e Ingeniería ya que sus plurales pueden formarse utilizando reglas 
que reflejan sus orígenes. En algunos casos puntuales, también aceptan el plural anglosajón, pero 
se decidió no incluirlos en el presente trabajo ya que siguen las reglas habituales de pluralización 
de sustantivos en inglés. Asimismo, teniendo en cuenta la existencia de plurales irregulares de 
orígenes italiano, francés y hebreo en el idioma inglés, se decidió no incluirlos en esta 
investigación porque dichos sustantivos pertenecen a campo semántico de otras disciplinas como 
la música, la literatura y otras artes. 

Es importante conocer el plural de las palabras de origen griego y latino porque puede ayudar a 
evitar errores al escribir y hablar, a comprender mejor su significado y a transmitir información 
exacta y precisa.  

 

2. Metodología 

Como se ha mencionado anteriormente, el objetivo de este trabajo es crear un diccionario de 
términos técnicos en inglés que aparecen en los campos de la Medicina y la Ingeniería, y que 
presentan plurales irregulares a la morfología inglesa, y por esta razón, siguen las reglas de 
declinación griega y latina. Para ello, se creó una lista de términos que presentan esta 
característica. Los términos fueron extraídos de manuales de ESP que se usan en las cátedras de 
Medicina e Ingeniería, así como también de diccionarios técnicos. 

Una vez recopilados dichos términos, se clasificaron de acuerdo a su origen y a la declinación que 
presentan. Las clasificaciones que se usaron son las siguientes: 

Plurales de origen latino: 

 Sustantivos terminados en -us pluralizan a -i  
 Sustantivos terminados en -um pluralizan a -a  

 Sustantivos terminados en -a pluralizan a -ae  
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 Sustantivos terminados en -ex o -ix pluralizan a -ices 

 Sustantivos terminados en -ax pluralizan a -aces 

 Sustantivos terminados en -x pluralizan a -ges  

 

Plurales de origen griego: 

 Sustantivos terminados en -is pluralizan a -es 
 Sustantivos terminados en -on pluralizan a -a 

 Sustantivos terminados en -ma pluralizan a -mata 

 Sustantivos terminados en -ris pluralizan a -rides 

 

Una vez realizada esta clasificación, se procedió a trabajar con la herramienta NooJ. El primer 
paso fue crear una gramática flexiva (File → New → Grammar). En la ventana emergente de 
creación de la nueva gramática, se seleccionó en tanto en input como output porque este trabajo 
se basa en el idioma inglés, y el tipo de gramática que se creó fue a través del editor de reglas, por 
lo que se seleccionó rule editor y finalmente Inflection & Derivation. 

 
Fig. 1. Creación de la gramática flexiva 

 

A continuación, se procedió a crear las reglas para cada uno de los grupos de sustantivos. Para 
ello, se tomó un término representativo de cada grupo y se usó su forma singular como nombre 
de la regla de flexión. Además, previamente se escribieron sus formas singular y plural 
antecedidos por el signo numeral (#) para que la línea no sea parte del código, sino que quede 
como referencia para el usuario. Para la escritura de las reglas, se siguieron los comandos 
genéricos que presenta el idioma en cuestión.  
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Fig. 2: Gramática flexiva 

 

A continuación, se listan los grupos flexivos según fueron escritos en la gramática: 

#cactus - cacti 

CACTUS = <E>/s | <B2>i/p ; 

#medium - media 

MEDIUM = <E>/s | <B2>a/p ; 

#vertebra - vertebrae 

VERTEBRA = <E>/s | e/p ; 

#vortex - vortices 

VORTEX = <E>/s | <B2>ices/p ; 

#thorax - thoraces 

THORAX = <E>/s | <B>ces/p ; 

#alumnus - alumni - alumna - alumnae 

ALUMNUS = <E>/s+m|<B2>a/s+f|<B2>i/p+m|<B2>ae/p+f ; 

#larynx - larynges 

LARYNX = <E>/s | <B>ges/p ; 

#basis - bases 

BASIS = <E>/s | <L><B>e/p ; 

#criterion - criteria 
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CRITERION = <E>/s | <B2>a/p ; 

#stigma - stigmata 

STIGMA = <E>/s | ta/p ; 

#iris - irides 

IRIS = <E>/s | <B>des/p ; 

 

Los comandos usados para crear las reglas fueron <E> para designar el elemento vacío, <B> para 
borrar el último carácter de la palabra y <L> para mover el cursor hacia la izquierda. Gracias a 
que la flexión nominal en latín y griego se basa, en su mayoría, en un cambio de sufijo, no se 
necesitó usar otro tipo de comando. La sintaxis de la regla de flexión es entonces: nombre del 
elemento representativo del grupo, signo igual, seguido de las distintas formas flexivas del 
elemento separadas por la barra vertical. Al tratarse de sustantivos en inglés, solo se realizó la 
flexión de número, por lo que cada forma está acompañada de /s para la forma singular y /p para 
la forma plural. Cabe aclarar que se creó una regla exclusiva para un único sustantivo que presenta 
flexión tanto de género como de número: alumnus. En este caso, las cuatro formas posibles se 
representaron con /s+m (singular masculino), /s+f (singular femenino), /p+m (plural masculino) 
y /p+f (plural femenino). 

 

 
Fig.3. Listado de términos en la gramática flexiva  

 

La gramática así creada se denominó: irregularplurals.nof. 

Una vez creada la gramática flexiva, se procedió a crear el diccionario. Para ello se seleccionó 
File → New → Dictionary y el idioma seleccionado fue inglés - en. Para crear el diccionario, se 
respetó el orden de los grupos que se crearon en la gramática. A su vez, dentro de cada grupo, los 
sustantivos fueron ordenados alfabéticamente para poder facilitar la lectura y la búsqueda del 
usuario.  
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Fig. 4. Diccionario de términos ordenados por tipo de flexión  

 

Para vincular este diccionario con la gramática, se escribió el comando use irregularplurals.nof. 
Además, para cada sustantivo, se escribió su forma singular, seguida de una coma, luego N, para 
definir su clase de palabra como sustantivo, y finalmente se incorporó el rasgo flexivo 
+FLX=______ donde se completó el espacio con el nombre del grupo flexivo al que pertenece, 
de acuerdo a lo definido en la gramática flexiva. El diccionario contiene 776 (setecientas setenta 
y seis) entradas por lo que, a modo ilustrativo, se presenta la lista de los primeros términos que 
conforman cada grupo del diccionario: 

 

acinous,N+FLX=CACTUS 

bacillus,N+FLX=CACTUS 

cactus,N+FLX=CACTUS 

calculus,N+FLX=CACTUS 

canaliculus,N+FLX=CACTUS 

 

acetabulum,N+FLX=MEDIUM 

addendum,N+FLX=MEDIUM 

aquarium,N+FLX=MEDIUM 

atrium,N+FLX=MEDIUM 

bacterium,N+FLX=MEDIUM 
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alga,N+FLX=VERTEBRA 

antenna,N+FLX=VERTEBRA 

axilla,N+FLX=VERTEBRA 

bulla,N+FLX=VERTEBRA 

bursa,N+FLX=VERTEBRA 

 

apex,N+FLX=VORTEX 

appendix,N+FLX=VORTEX 

cervix,N+FLX=VORTEX 

cicatrix,N+FLX=VORTEX 

codex,N+FLX=VORTEX 

 

cephalothorax,N+FLX=THORAX 

hemothorax,N+FLX=THORAX 

hydrothorax,N+FLX=THORAX 

mesothorax,N+FLX=THORAX 

metathorax,N+FLX=THORAX 

 

alumnus,N+FLX=ALUMNUS 

 

coccyx,N+FLX=LARYNX 

hypopharynx,N+FLX=LARYNX 

larynx,N+FLX=LARYNX 

leptomeninx,N+FLX=LARYNX 

meninx,N+FLX=LARYNX 

 

abiogenesis,N+FLX=BASIS 

abiosis,N+FLX=BASIS 

acariasis,N+FLX=BASIS 

acidosis,N+FLX=BASIS 

actinomycosis,N+FLX=BASIS 

 

automaton,N+FLX=CRITERION 

criterion,N+FLX=CRITERION 
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ephemeron,N+FLX=CRITERION 

ganglion,N+FLX=CRITERION 

 

aceldama,N+FLX=STIGMA 

adenocarcinoma,N+FLX=STIGMA 

adenoma,N+FLX=STIGMA 

aerenchyma,N+FLX=STIGMA 

 

arthritis,N+FLX=IRIS  

clitoris,N+FLX=IRIS 

epididymis,N+FLX=IRIS 

iris,N+FLX=IRIS 

rachis,N+FLX=IRIS 

 

Una vez creado el diccionario, se le dio el nombre irregularplurals.dic. Para finalizar, se compiló 
el diccionario. Para ello, se seleccionó Lab → Dictionary. En la ventana emergente se seleccionó 
el diccionario y finalmente se hizo clic en Compile. De esta forma, el diccionario se compiló en 
el formato .nod.   

 

 
Fig. 5. Compilación del diccionario 
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Para visualizar el diccionario con todas las formas flexionadas, se seleccionó la opción Lab → 
Dictionary y luego Inflect. De esta manera, se generó un diccionario de 1554 (mil quinientas 
cincuenta y cuatro) entradas con todas las formas posibles que se definieron en la gramática 
flexiva. A modo ilustrativo, se muestran los primeros seis términos de este nuevo diccionario, 
donde aparecen primero la forma flexionada, luego el sustantivo del cual deriva, y finalmente las 
características de la forma flexionada. 

acinous,acinous,N+FLX=CACTUS+s 

acinoi,acinous,N+FLX=CACTUS+p 

bacillus,bacillus,N+FLX=CACTUS+s 

bacilli,bacillus,N+FLX=CACTUS+p 

cactus,cactus,N+FLX=CACTUS+s 

cacti,cactus,N+FLX=CACTUS+p 

 

3. Análisis lingüístico 

 

Para verificar la herramienta creada, se decidió ejecutar un proyecto utilizando el diccionario 

generado. Para ello, en la herramienta NooJ los pasos fueron Project → Run Project finalizando 

con la selección del archivo creado. Una vez abiertos los archivos, se seleccionó File → New 

Text, y en la nueva ventana se redactó la siguiente oración: 

The doctor diagnoses fungi on the patient's skin by observing cilia under the microscope . 

Se realizó un análisis lingüístico y se seleccionó el comando Show Text Annotation Structure, 

donde se puede ver toda la información completa de cada uno de los elementos.  

 

 
Fig. 6. Análisis lingüístico 
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Como se muestra en la figura 6, los resultados del análisis lingüístico dan cuenta de las entradas 
nuevas del diccionario creado. En primer lugar, se comprueba la entrada diagnoses como el plural 
irregular de diagnosis. Sin embargo, la herramienta NooJ también propone en este caso la función 
de verbo conjugado en tercera persona del singular en tiempo presente. En segundo lugar, la 
palabra fungi es reconocida como el plural irregular de fungus. 

En el ejemplo anterior, se puede notar la importancia que tiene la herramienta NooJ en el análisis 
lingüístico de textos técnicos-científicos. La cantidad de palabras homógrafas que existen 
en las lenguas, y particularmente en inglés, por tratarse de una lengua poco flexiva en 
comparación con las lenguas romances, conduce a dificultades en la interpretación de los 
textos. Además, la preponderancia de sustantivos con plurales irregulares de orígenes 
extranjeros dificulta el rastreo del lema del que parten. Por esta razón, el análisis 
lingüístico que aporta NooJ permite sortear algunas dificultades en el aprendizaje del 
léxico e interpretación de los textos técnico-científicos de los campos de la Medicina y la 
Ingeniería, al poner en evidencia aquellos vocablos que presentan cierta irregularidad en 
su flexión. 

 

4. Conclusión 

La creación de un diccionario de términos médicos e ingenieriles con NooJ ha demostrado ser 
una herramienta extremadamente valiosa. Los términos en inglés que presentan plurales 
irregulares de origen latino y griego son muy comunes en estos campos, y la gestión de la 
terminología es fundamental para garantizar la precisión y la claridad de la comunicación técnica 
y científica. La utilización de NooJ ha permitido la identificación y el análisis precisos de estos 
términos, lo que ha llevado a la creación de un recurso útil y práctico para los profesionales y 
estudiantes de estas áreas. 

Cabe destacar que NooJ es una herramienta muy importante en el procesamiento del lenguaje 
natural y la lingüística computacional. Su capacidad para analizar grandes cantidades de datos 
lingüísticos en diferentes idiomas es esencial para la investigación lingüística y el desarrollo de 
nuevas tecnologías. Además, su aplicación en la enseñanza del inglés con fines específicos es 
muy relevante, ya que permite una comprensión más profunda y precisa de los términos técnicos 
y científicos. 

En resumen, la creación de este diccionario de términos médicos e ingenieriles utilizando NooJ 
representa un paso importante hacia la mejora de la comunicación técnica y científica. Esperamos 
que este trabajo pueda servirle como recurso a todos aquellos docentes de inglés en los ámbitos 
médico e ingenieril que trabajen con léxico específico, y resulte útil como material de referencia. 
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